
Welcome to PMdiff for Windows 95 and NT 4.0

PMdiff displays the differences between files and folders in a graphical manner. File comparison windows display 
two files side by side, highlighting the differences between them with connecting lines.

PMdiff helps you merge different versions of a file. Simply select the changes that you want to keep in the final 
merged version. For more advanced merging, you can open an editing window that contains the merged file. You 
can then edit the file before saving it.
 
PMdiff can also compare folder (directory) trees and the files within them. Using this and the other features in 
PMdiff, you can compare and/or merge large numbers of files with ease.

PMdiff is ideally suited to team working where more than one person is working on a set of files, as well as many 
other situations. Use PMdiff to assist in software development or in managing different versions of World Wide Web 
HTML files.

Finally, remember that on-line help is available for all the windows, dialogs, menus, and toolbars within PMdiff. For 
windows and dialogs, ensure that the window or dialog has keyboard focus, and then press the F1 key. For menus, 
highlight the menu command you want help for, and then press F1. For toolbar buttons, click down on the button, 
and then press F1 before releasing the mouse button. Help is also available via the commands in the Help menu in
the PMdiff application window.

Related Topics:

  Comparing Files      Contacting Araxis

  Comparing Folders      Warranty

  Merging Files      License Agreement

  Options      Order Form

Opens a window which you can use to compare folder hierarchies.



Opens a window which you can use to compare files.



Displays a window which you can use to set PMdiff options.



Closes all open file comparison and editing windows.



Opens a file browsing window that you can use to locate a file to compare with the file in the first file panel.



Refreshes the contents of the active window.



Swaps the contents of the first and second file panels.



Opens a file browsing window that you can use to locate a file to compare with the file in the second file panel.



Closes the active window.



Selects all removed and changed lines in the first file.



Deselects all selected lines in the first file.



Creates a merged file consisting of all the selected lines from the first and second files, and then displays a save 
file window which you can use to save the merged file. The ticks at the top-right of each set of lines in the file 
panels indicate which lines will be used to create the merged file.



Selects all inserted and changed lines in the second file.



Deselects all the selected lines in the second file.



Creates a merged file consisting of all the selected lines from the first and second files, and then displays a save 
file window which you can use to save the merged file. The ticks at the top-right of each set of lines in the file 
panels indicate which lines will be used to create the merged file.



Turns the line selection boxes and file merging features on and off.



Displays a window which you can use to set PMdiff options.



The OLE2 libraries could not be initialized. You may be running low on resources, or your Windows installation may 
have become damaged in some way.



Comparing Files

The file comparison window is opened by selecting the Compare Files...  command from the File menu in the 
PMdiff application window, or indirectly by a folder comparison window.

The comparison window is used to compare two files and to display the differences between them. You can choose 
the two files to compare in several different ways.

· Type a filename into one or both of the filename fields at the top of the file comparison window.
· Select previously compared files from the filename field dropdown lists
· Use the file browsing buttons at the right-hand side of each filename field
· Right-click on either of the two file panels, and select the Open  command from the popup menu. 

· Drag and drop files from Windows Explorer or other applications onto the filename fields or either of the 
file panels.

When you have selected the files you want to compare, press Enter, or click the Refresh  button to begin 
comparing the two files.

If you drop one or more files from Windows Explorer onto the PMdiff application window, then a file comparison 
window will be opened to compare the dropped files. You can also drop folders onto the application window, in 
which case a folder comparison window will be opened to compare the dropped folders.

Connected lines drawn between the files highlight the differences between the two files. The two files are 
automatically linked together so that their visible centers are as similar as possible. You can alter how the linking 
works by changing the options in the Linking Options property page.

You can use the scrollbars to scroll forwards and backwards within the two files. There are also four small buttons 
at the bottom outer edges of the window that can be used to skip the cursor forwards or backwards to the next or 
previous change in each file.

You can also use the keyboard to move around within the files. Click within the file panel you want to move about 
in to give it keyboard focus, and then use the cursor keys to move around. Use Ctrl + Page Up to move to the 
previous change, and Ctrl + Page Down to move to the next change. You can select text from the files and copy 

it to the clipboard by pressing Ctrl + C, or by clicking on the Copy  button in the toolbar. Use the Spacebar to 
toggle line selection check-boxes on and off.

The number of file comparison windows that you can have open at any one time is only limited by the number of 
free resources in your computer. You can create multiple views onto the same file comparison window by selecting 
the New Window  command from the Window menu. 

Clicking the right mouse button on either of the two file panels will display a shortcut menu. This menu enables you
to carry out common operations on the two files in a convenient way.

Related Topics:

  Comparing Folders      Options

  Merging Files

This shortcut menu contains commands for commonly used operations.



This window contains copyright and version information for PMdiff.



Comparing Folders

Selecting the Compare Folders...  command from the File menu in the PMdiff application window opens a 
folder comparison window.

To compare two folder structures, type the two paths into the entry fields at the bottom of the window.    You can 
also use the browse buttons and the drop-down lists to select folder names, or drag and drop folders from Windows
Explorer onto the directory fields. Click the Refresh button to compare the two folder structures and fill the list 
with the results of the comparison. 

The window will display an hourglass cursor while it compares the two folder structures. PMdiff is multithreaded in 
all the right places: while the comparison is in progress, you can still use the other facilities in PMdiff, such as file 
comparison windows and on-line help. You do not need to wait for a comparison to finish before comparing other 

folders. Just enter the new folder names into the folder fields, and click the Refresh  button on the toolbar. 

Each file is displayed next to an icon that indicates the state of the file.

 The file is unchanged between the two folders

 The file only appears in the first folder

 The file only appears in the second folder

 The file has been changed between the two folders

A red dot in the top-left corner of the icon is used to indicate which of the two (left and right) files is more recent.

By default, PMdiff performs a full file comparison between files to check whether they have been modified between 
the two folder hierarchies. This can be time-consuming for large folder hierarchies. You can speed up folder 
comparisons at the expense of some accuracy by deselecting the Perform a thorough (rather than quick) 
comparison option in the Folder Comparison property page.    When this option is disabled, PMdiff will check the 
file timestamps and sizes to decide whether a file has changed.

When the list has been filled with files, you can highlight the files you wish to compare. The list supports multiple 
selection so you can highlight a number of files before comparing them. You can also click the Select Changed 
button to highlight all the changed  files.

When you have highlighted some files, click the Compare Selected button. One file comparison window will be 
opened for each pair of files you have highlighted. These file comparison windows are normal file comparison 
windows and work in the usual way. Folders highlighted within the list are ignored. The highlighting is removed 
from files for which file comparison windows have been opened.

You can alter the way file comparison windows are opened by changing the settings on the Folder Comparison 

options page. Access this page by selecting the Options...  command from the View menu, and then clicking 
on the Folder Comparison tab.

In particular, it is possible to apply file filters to the folder comparison. You can use this option to make PMdiff 
ignore files and folders that match a particular pattern, or include only those files that match a pattern.

Related Topics:

  Comparing Files      Options

  Merging Files

The Styles Options Page

Styles



The buttons in this group enable you to change the font and color for each type of line that can be displayed in file 
comparison windows.

Unchanged lines are lines that are the same in the first and second files. Changes lines are lines that have changed
between the first and second files. Removed lines are those that only appear in the first file. Inserted lines only 
appear in the second file.

Click one of the buttons to display a standard font dialog that you can use to pick a font and color.

Colors
Overview strips are the two vertical strips drawn in file comparison windows on the outer edges of the file panels. 
Click this button to display a color dialog from which you can pick the color to use for these strips.

Linking lines are the lines drawn in the center of file comparison windows, and which also extend out over the file 
panels.

Related Topics:

  Options



The Linking Options Page

Vertical linking
When this option is checked, PMdiff will ensure that the two files are always aligned so that the lines at the center 
of the two panels match as closely as possible. Scrolling one file up and down will cause the other file to move as 
well.

Horizontal linking
When this option is checked, PMdiff will match the horizontal scroll positions of the two files. As one file is scrolled 
from side to side the other will be scrolled as well.

Delayed linking
When this option and Vertical Linking are both checked, and a file is scrolled up and down with the scroll bar's 
thumb, PMdiff will not update the vertical position of the other file until the thumb is released. This may be useful 
on computers with slow graphics cards.

Extend linking lines across documents
When this option is checked, the lines drawn within the central lines panel are extended across the two file panels. 
This makes it easier to see which lines are part of each change block. If your computer has a slow graphics 
adapter, you can try turning this option off to see if it improves scrolling speed.

Show center line marker
When this option is checked, a horizontal line is drawn halfway down the central lines panel. It is at this vertical 
position that the two files are linked together.

Show linking overview strips
When this option is checked, PMdiff will insert change overview strips on the inner edge of each vertical scrollbar in 
the file comparison window. Each overview strip represents the entire file, and the marks within it indicate the 
relative positions of changes within the file. The markings next to the scroll bar’s thumb show changes that are 
currently visible.

Related Topics:

  Options



The Miscellaneous Options Page

Maximize PMdiff on start-up
Check this option to make PMdiff cover the whole screen when started.

Open an empty file comparison window on start-up
Check this option to have PMdiff open an empty file comparison window when the PMdiff application window first 
opens.

Open an empty folder comparison window on start-up
Check this option to have PMdiff open an empty folder comparison window when the PMdiff application window first
opens.

Confirm PMdiff close when file comparison windows are open
Check to make PMdiff display an exit confirmation message box when PMdiff is closed and there are still some file 
comparison windows open.

If you are working with maximized file comparison and editing windows, it is sometimes possible to accidentally 
click on the application close button instead of the comparison window close button. If this option is checked, then 
you’ll be given a chance to cancel the operation before PMdiff disappears.

Maximize file comparison windows when they open
Check to make file comparison windows automatically maximize themselves when they open. If you normally work 
with maximized file comparison window, then this option will save you having to manually maximize them when 
they open.

Related Topics:

  Options



The Lines Options Page

Hide trailing CR and LF characters
When this option is checked, PMdiff will strip the trailing Carriage Return and/or Line Feed characters from the end 
of each line. This is purely a visual option, and does not affect the line endings used when files are saved.
 
Show line numbers
When this option is checked, PMdiff will display the line numbers at the left of each file-viewing panel.

Expand tabs to # spaces
Check this option and fill in the entry field if you want PMdiff to expand tab characters to spaces within compared 
files.

Don’t ignore whitespace
Select this option to make PMdiff treat whitespace (space and tab characters) as being significant when comparing 
lines.

Ignore whitespace at start of lines
Select this option to ignore whitespace at the beginning of each line.

Ignore all whitespace
Select this option to ignore all whitespace within lines.

If you are comparing two files, one with Windows style line endings (CR LF) and the other with UNIX style line 
endings (LF), then select the Ignore all whitespace option to ignore the line-ending type when comparing the 
files.

Ignore case of characters in lines
Select this open to make PMdiff ignore the case of characters within lines.

Related Topics:

  Options



The Folder Comparison Options Page

This page contains a large number of options that you can use to customize the way PMdiff compares folders and 
opens file comparisons windows from folder comparison windows.

Minimize window after opening file comparison views
When this option is checked, folder comparison windows will automatically minimize themselves after opening file 
comparison windows. If the number of open file comparison windows is limited (see below), then the window will 
not minimize itself until it has been able to open all the file comparison windows.

Perform a thorough (rather than quick) comparison
By default, PMdiff performs a full file comparison between files to check whether they have been modified between 
the two folder hierarchies. This can be time-consuming for large folder hierarchies. You can speed up folder 
comparisons at the expense of some accuracy by unchecking this option.    When this option is disabled, PMdiff will 
check the file timestamps and sizes to decide whether a file has changed.

Recurse into sub-folders
If this option is checked, then the folder comparison window will compare files by recursively descending through 
the sub-folders within the two comparison folders. If the option is unchecked, then only the files at the top-level of 
the comparison folders will be displayed.

Show unchanged files
Check this option to include files in the list even if they haven’t changed between the two folders.

Show inserted and removed files
Check this option to include inserted and removed files in the list.

Ignore files that match X
Fill in, or edit the entry field to filter out files that match a particular pattern. Files that match will not be included 
in the list of files. Use a semicolon or comma to separate patterns in the list. You can also enter folder names into 
this entry field, but be sure to add a \ trailing character to distinguish folders patterns from file patterns.

Include only files that match X
This option complements the previous option. You can specify a filter so that only files and folders matched by the 
filter will be included in the folder comparison results list.

Close if files were identical
If there turn out not to be any differences between two files in one of the newly opened file comparison windows, 
then the window will automatically close itself. This option can be useful if you have disabled the Perform a 
thorough (rather than quick) comparison option (above).

Close if either file could not be found
When this option is checked, the file comparison windows will automatically close themselves if an error occurs 
during comparison, or either of the two files being compared is not found. This is unlikely to happen, but will 
prevent pointless windows from remaining open if it does.

Limit the number of open views to x

There's nothing more annoying than clicking the Compare Selected  button and having several hundred file 
comparison windows all open up at once. By checking this option, and filling in the limit entry field you can restrict 
the number of file comparison windows that the comparison window will open. This option also helps under 
Windows 95 where system resources are somewhat limited.

Once you've examined and closed some of the opened comparison windows that were opened, you can click the 
Compare Selected button again and some more file comparison windows (up to the limit) will be opened. If you 
have the Minimize window after opening file comparison views option checked, then the window will 
minimize itself when there are no more files to compare.

Related Topics:

  Options



Use this window to select a color by clicking on a color box, and then clicking on the OK button.



Just a little logo window.



Enter the name of the first folder to compare into this field. You can also select a folder name from the drop-down 
list, or click the Browse  button to open a folder browsing window.



Enter the name of the second folder to compare into this field. You can also select a folder name from the drop-
down list, or click the Browse  button to open a folder browsing window.



Click to change the color of the lines used to indicate changes between the two files.



Toggles delayed linking on or off. When linking is delayed and a file is scrolled with a scrollbar, the other file will 
only snap into position when you stop scrolling.



Sets the number of spaces represented by each tab stop.



Select if you want all whitespace to be considered significant when comparing files.



Select if you want to ignore leading whitespace on each line when comparing files.



Select if you want to ignore all whitespace when comparing files. Use this option when comparing files that have 
different line-endings.



Select to have the file comparison windows automatically close if either of the two compared files being compared 
could not be found or opened.



Check to have the file comparison windows automatically close if the two compared files are identical.



Limits the number of views that the folder comparison facility will open at any one time. This can be used to limit 
resource utilization under Windows 95.



Limits the number of views that the folder comparison facility will open at any one time. This can be used to limit 
resource utilization under Windows 95.



To extend lines across the file panels, select this option. When enabled, it is easier to see the relationships between
blocks of changed lines.



Turns the center line marker on or off. The center marker provides a useful point of reference because it is at the 
marked point that the files are linked together.



Hides the Carriage Return and Line Feed characters at the end of each line.



Displays line numbers at the start of each line.



Links the two files so that when one is scrolled vertically the other scrolls too.



Links the two files so that when one is scrolled horizontally the other scrolls too.



Expands all tab characters into the appropriate number of spaces when the files are displayed.



Expands all tab characters into the appropriate number of spaces when the files are displayed.



Check to have PMdiff cover the whole screen when it starts.



Check if you want folder comparison windows to minimize automatically when they have compared all selected 
files.



Check to show a linking overview strip next to each file. These strips provide a simple overview of the changes 
within each file.



Click to change the color used to display changes in the overview strips.



Click to change the font and color used to indicate unchanged lines.



Click to change the font and color used to indicate changed lines.



Click to change the font and color used to indicate inserted lines.



Click to change the font and color used to indicate removed lines.



Check to enable the file merging commands and features.



Check to have PMdiff perform a thorough comparison to determine whether files have been changed between 
folders. When enabled, PMdiff takes longer to fill the file list and is completely accurate. When disabled, PMdiff 
makes an educated guess as to whether files are identical.



Select to have PMdiff recursively descend through sub-folders while comparing the two folder structures. When 
disabled, PMdiff will only look for files in the two named folders themselves.



Use this control to increase or decrease the limit on the number of open file comparison windows that will be 
opened at any one time by folder comparison windows.



Use this control to increase or decrease the number of spaces represented by each tab stop.



That’s just a menu item separator!



Closes the active window.



Opens a new window onto the two files displayed in the file comparison window.



Arranges minimized windows neatly along the bottom edge of the PMdiff application window.



Cascades all open windows from the top-left towards the bottom-right.



Tiles all open windows so that all are visible and none overlap.



Tiles all open windows so that all are visible and none overlap.



Opens a window containing version and copyright information for PMdiff.



Closes PMdiff.



Displays the PMdiff on-line help index page.



Displays PMdiff on-line help topics.



Displays an on-line help window that explains how to use the on-line help system.



Activates the context-sensitive on-line help system.



Displays on-line help for the active window or control.



Displays on-line help for PMdiff.



Activates the next pane within the active window.



Activates the previous pane within the active window.



Toggles the PMdiff toolbar on and off.



Toggles the PMdiff status bar on and off.



Saves the changes you have made in this window and applies them to PMdiff without closing the window.



Opens the named window.



Opens the named window.



Click to close this window and save any changes you have made.



Click to close this window and discard any changes you have made.



Click to apply changes that you have made to this window without closing it.



Merging Files

PMdiff file comparison windows enable you to merge together two files by selecting the lines you want saved from 
each file.

To merge two files in a file comparison window, ensure that the Enable Merging  command is checked in the 
popup menu you get by right-clicking on one of the files.

Unchanged, changed, inserted, and removed lines are automatically grouped together into change blocks. Each 
change block is assigned a check-box. This check-box appears at the top-right of each change clock. By default, all 
the check-boxes for the first file are checked, and all the check-boxes for the second file are unchecked.

PMdiff creates a merged file by simply collecting all the change blocks that have been selected by a check in their 
check-box. Change blocks that are not checked will not be included in the merged file. By checking and unchecking 
change blocks, you can add and remove lines from the merged file.

You can check and uncheck change blocks in the following ways:

· Position the cursor within a change block, and press the Spacebar. This will cause the check-box for the 
current change block to be toggled on and off.

· Click on change-block’s check-box with the mouse. This will cause the check-box to be toggled on and off.

Usually, when a check-box is toggled on or off, the check-box for the corresponding change block (for blocks of 
unchanged or changed lines) in the other file will also be toggled on and off. You can prevent the other file’s check-
box from being toggled by holding down the Shift key when you toggle a check-box. If you check a change block 
and its corresponding change-block in the other file, then the merged file will contain the change-block from the 
first file followed by the change-block from the second file.

You can preview or edit the merged file at any time. Select the Edit Merged File  button on the toolbar, and an
editing window will open. This window will display the merged file. Lines from the first and second file are color 
coded so you can tell which file each line came from.

You can save the merged file from the editing window, or from the file comparison window. Select a Save  
command from the File menu, or right-click on a file and select a Save command from the popup menu.

Related Topics:

  Comparing Files      Options

  Comparing Folders

 ATrademarks

Araxis™ and PMdiff™ are trademarks of Araxis Ltd.

Windows™, Win32™, Windows NT™, and Windows 95™ are trademarks of Microsoft® Corporation.

OS/2™ and Presentation Manager™ are trademarks of IBM® Corporation.

All other trademarks acknowledged.



PMdiff Order Form

NOTE: You can order copies of PMdiff on-line and from other distributors that may be more appropriate for your 
location. See http://www.araxis.com/html/order_pmdiff.html for further details.

You can click on the Print button above to print out this form ready for mailing.

                  Mail Orders To: BMT Micro
                                  PO Box 15016
                                  Wilmington, NC 28408
                                  U.S.A.

                    Voice Orders: 8:00am - 7:00pm EST (-5 GMT)
                                  (800) 414-4268 (orders only)
                                  (910) 791-7052

                      Fax Orders: (910) 350-2937  24 hours / 7 Days
                                  (800) 346-1672  24 hours / 7 Days

                    via Internet: orders@bmtmicro.com
                                  http://www.bmtmicro.com

        Secure Ordering: http://www.bmtmicro.com/info/placeorder.html

     Ordering and general ordering questions:

                            Via AOL: bmtmicro
                         Via Prodigy: HNGP66D
                    Via Compuserve: 74031,307

     We accept Visa, Mastercard, Discover, American Express, Diners
     Club, Carte Blanche, Cashiers Check, Personal Check.   Personal
     checks are subject to clearance.  Eurochecks in DM are welcome.
     DM, Sterling, and US Currency is welcome but send only by
     registered mail, return receipt requested.   We cannot be liable
     for lost cash sent through the mail.

     If you reside in a country with an unconvertible currency please
     contact us for alternatives.

     Information for our German customers is explained in the last
     paragraph of this order form.

     _____________________________________________________________________

     Company:_____________________________________________________________

     Name:________________________________________________________________

     Address:_____________________________________________________________

             _____________________________________________________________

     City: _______________________________State/Province: ________________

     Postal/ZIP Code: ____________________Country:________________________

     Phone:_______________________________________________________________

     Fax:  _______________________________________________________________

     E-Mail #1____________________________________________________________

     E-Mail #2____________________________________________________________

     NOTE: These US$ prices are correct at the time of publication, but



     Araxis reserves the right to change them without notice. Check the
     PMdiff home page (http://www.araxis.com/html/pmdiff.html) for the
     latest information.

     Product                         Unit Price    Number of Units
     ______________________________  __________    _______________

     PMdiff 4.6 for Win32 (single)   ....$79.00  x _________ = + $ _______
 
     PMdiff 4.6 for Win32 (5 pack)   ...$375.00  x _________ = + $ _______
 
     PMdiff 4.6 for Win32 (10 pack)  ...$710.00  x _________ = + $ _______

     PMdiff 4.6 for Win32 (20 pack)  ..$1265.00  x _________ = + $ _______

     PMdiff 4.6 for Win32 (50 pack)  ..$2765.00  x _________ = + $ _______

     PMdiff 4.6 for Win32 (100 pack) ..$4740.00  x _________ = + $ _______

     Supplied on diskette            .....$3.00  x _________ = + $ _______

     PMdiff 4.0c for OS/2 (single)   ....$30.00  x _________ = + $ _______

     PMdiff 4.0c for OS/2 (5 pack)   ...$142.00  x _________ = + $ _______

     PMdiff 4.0c for OS/2 (10 pack)  ...$270.00  x _________ = + $ _______

     PMdiff 4.0c for OS/2 (20 pack)  ...$480.00  x _________ = + $ _______

     PMdiff 4.0c for OS/2 (50 pack)  ..$1050.00  x _________ = + $ _______
 
     PMdiff 4.0c for OS/2 (100 pack) ..$1800.00  x _________ = + $ _______

     Supplied on diskette            .....$3.00  x _________ = + $ _______

     North Carolina Residents add 6% Sales Tax                   $ _______

     Shipping and Handling (no quantity limit / see below)       $ _______

       Email - Subject to Credit Card Verification     Free
       Worldwide 1st Class .......................     Free
       2nd Day Priority, USA Only ................ $   4.00 US
       US Postal Service International Express
         (Including Canada and Mexico), allow up to
         7-10 days ............................... $  25.00 US
       Airborne Select Delivery  (USA Only)        $   8.00 US
       FedEx Overnight, USA Only (delivery by
         3:00 pm the following day) .............. $  15.00 US
       FedEx Europe/Japan (guaranteed delivery
         within 3 days) .......................... $  35.00 US

     Total:                                                      $ _______

      For credit card payment only

      Circle one: VISA / Master / Discover / American Express / Diners

      Credit card number: _____________________________________________

      Expiration date: ________________________________________________

      Authorization signature: ________________________________________

                   ORDERING FROM INSIDE GERMANY ONLY
                   =================================



Persons in Germany wishing to order shareware may also transfer funds
into our account with Deutsche Bank.   Once the money is deposited you
may either fax a confirmation to us with proof of deposit or wait until
Deutsche Bank notifies us of the transaction (usually 10-18 business days).
Account information is as follows:

Deutsche Bank / Frankfurt Branch
Empf„nger:  Thomas Bradford
Konto-Nummer: 0860221
Bankleitzahl: 500-700-10

When you make the transfer, be sure to put your name and the program you
are registering on the transfer.

Current exchange rates can be obtained by sending an email to
dm_to_us@bmtmicro.com.   An automated reply will return todays exchange
rates.

It is very important that you send us a completed order form by
either email or fax if you deposit money into this account for a
registration.  Fill the order form out as usual except in the credit
card number field put "DEUTSCHE BANK".   We will file the order and
use it to match against the deposit information we receive from the
bank.

                               IMPORTANT!
                               ----------
When you email us your order form, we will reply with an
acknowledgement.   If you do not get an acknowledgement within 24 hours
please send your order again in case it was lost.  This extra bit of
caution can save a lot of confusion.

If you are concerned that your order is taking too long to process, feel
free to check with us about the status of your order.   It's important
to all of us that you feel safe doing business with our company and
please feel free to suggest ways we can improve our service to you.



License Agreement

IMPORTANT - READ CAREFULLY:    This ARAXIS PMdiff License Agreement ("Agreement") is a legal agreement 
between you (either an individual or a single entity) and Araxis Ltd ("ARAXIS") for ARAXIS' PMdiff computer 
software and any associated media (collectively, the "Licensed Software"). By continuing to use the Licensed 
Software, you agree to be bound by the terms of this Agreement.

1. COPYRIGHT

The Licensed Software is owned by ARAXIS and is protected by United Kingdom copyright laws and international 
treaty provisions. Therefore, you must treat the Licensed Software like any other copyrighted material (e.g., a book
or musical recording), except that you may either (i) make one copy of the Licensed Software solely for backup or 
archival purposes, provided you reproduce and include ARAXIS' copyright and trademark notices contained on the 
original disk labels on such backup copy, or (ii) transfer the Licensed Software to a single hard disk, provided you 
keep the original solely for backup or archival purposes. You may not copy any written materials which may 
accompany the Licensed Software.

2. OTHER RESTRICTIONS

You may not use, copy, or modify the files containing the Licensed Software, or any backup copy, in whole or in 
part, or translate such files into any other file format or language, except as expressly provided for in this 
agreement. You may not rent, lease or sublicense the Licensed Software, but you may transfer the Licensed 
Software and accompanying written materials on a permanent basis, provided you retain no copies, the recipient 
agrees to the terms of this License Agreement and immediately contacts ARAXIS to inform ARAXIS of such transfer.
Upon such transfer, your license under this License Agreement is automatically terminated.

You may not reverse engineer, decompile or disassemble the Licensed Software for any purpose whatsoever.

3. TERM

Your license is effective upon your acceptance of this agreement and installing the Licensed Software. You may 
terminate it at any time by destroying the Licensed Software together with all copies. It will also terminate upon 
conditions set forth elsewhere in this Agreement or if you fail to comply with any term or condition of this 
Agreement. You agree upon such termination to destroy all copies of the Licensed Software in any form in your 
possession or under your control.

4. WARRANTY

ARAXIS OFFERS NO WARRANTY OF PERFORMANCE, EXPRESS OR IMPLIED, WITH REGARD TO THE LICENSED 
SOFTWARE AND ALL ACCOMPANYING MATERIALS. ARAXIS FURTHER DISCLAIMS ALL OTHER WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE, WITH REGARD TO THE LICENSED SOFTWARE AND ALL ACCOMPANYING 
MATERIALS.
 
5. CUSTOMER REMEDY

ARAXIS DISCLAIMS ALL LIABILITY AND OFFERS NO CUSTOMER REMEDY WITH REGARD TO THE LICENSED 
SOFTWARE AND ALL ACCOMPANYING MATERIALS.

6. DISCLAIMER OF DAMAGES

You assume responsibility for, among other things, (i) the selection of the Licensed Software to achieve your 
intended results, (ii) the acquisition of other software (including any programming or operating system software) 
and/or equipment compatible with the Licensed Software, and (iii) the installation, use and results obtained from 
the Licensed Software. Further, for the express purpose of limiting the liability against ARAXIS, you agree that, to 
the maximum extent permitted by law, ARAXIS SHALL IN NO EVENT BE LIABLE FOR ANY DAMAGES WHATSOEVER 
(INCLUDING WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, 
LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OR INABILITY 
TO USE THE LICENSED SOFTWARE, WHETHER DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL, SPECIAL OR 
OTHERWISE, REGARDLESS OF THE FORM OF ACTION, EVEN IF ARAXIS HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES.

7. UPDATES

ARAXIS may, from time to time, revise or update the Licensed Software. In so doing, ARAXIS incurs no obligation 



to furnish such revision or updates to you.

8. GENERAL

This License is personal between you and ARAXIS. It is not transferable and any attempt by you to rent, lease, 
sublicense, assign or transfer any of the rights, duties or obligations hereunder, except as provided in Section 2, 
above, is void. This Agreement and the conduct of the parties hereto shall be governed by the laws of the United 
Kingdom.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT AND AGREE TO BE BOUND BY ITS 
TERMS AND CONDITIONS. YOU FURTHER AGREE THAT IT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF THE 
AGREEMENT BETWEEN YOU AND ARAXIS WHICH SUPERSEDES ANY PROPOSAL OR PRIOR AGREEMENT, ORAL OR 
WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN YOU AND ARAXIS OR ARAXIS' AGENT(S) RELATING TO 
THE LICENSED SOFTWARE.

Related Topics:

  Warranty



Contacting Us

Do you like PMdiff? Loathe it? Whatever you think, tell us!

Your opinions matter! We want to produce the best applications available: we can only do that with your help. 
Maybe you have a suggestion for improving PMdiff? Perhaps you think you’ve found a fault? 

You can e-mail your comments and questions to us at the following email addresses:

bugs@araxis.com Use this address to report bugs in Araxis products. Please include 
the product name and version somewhere in the Subject line. 
Please try to include sufficient information for us to reproduce the 
problem – screenshots are usually very helpful.

suggestions@araxis.com Use this address if you want to send us suggestions for things to 
include, remove, or change in our products. 

sales@araxis.com Use this address for sales and licensing related inquiries.
support@araxis.com Use this address for everything else!

You can find our Web site at http://www.araxis.com/



Warranty

Your attention is drawn to sections 4, 5 and 6 of the PMdiff license agreement (see Related Topics below).

Related Topics:

  License Agreement



Options

You can set PMdiff options by selecting Options... from the View menu, or by clicking the Options  button on 
the toolbar.

Related Topics:

  Styles Options      Merging Options 

  Lines Options      Folder Comparison 

  Linking Options      Miscellaneous 

Displays a preview of what will be sent to the printer when you print the active document.



Click to open a file comparison window for each pair of selected files in the list.



Displays a window containing PMdiff on-line help topics.



Check this option to include unchanged files in the folder comparison list.



Check this option to include inserted and removed files in the folder comparison list.



Check this option to filter out files and/or folders that match the patterns in the adjacent entry field.



Copyright and version information for PMdiff.



Click this button to browse for a folder to compare.



This list contains the results of the folder comparison operation.



Click this button to browse for a folder to compare.



Enter the patterns that match the types of file that should be ignored when comparing folders. For example, enter 
*.obj to ignore all files ending in .obj. Use the ; or , characters to separate multiple patterns. Use a trailing \ 
character to distinguish folders from files. You can also enter non-wildcard names of files or folders that you would 
like to be ignored.



Click to close the window.



This is the main PMdiff toolbar.



Check to ignore the case of characters when comparing lines.



Check to make PMdiff open an empty file comparison window when PMdiff first starts.



Check to make PMdiff display an exit confirmation message box when PMdiff is closed and there are still some file 
comparison windows open.



To close PMdiff, select Yes. Otherwise, select No.

You can disable this message prompt by changing the appropriate option in the Miscellaneous options page.



Neither of the two folders that were entered in the folder comparison window could be found. Check the contents of
the two edit fields.



The specified folder could not be located.



Command Line Options
PMdiff [</RegServer>] [</Automation>] [</Embedding>] [</NoSplash>] [</NoSplashDelay>] [<file1 
[file2]> | <folder1 [folder2]>]

Option Description
RegServer Forces PMdiff to re-register all its automation capabilities
Automation Used when PMdiff is started an automation server
Embedding Used when PMdiff is started an automation server
NoSplash Don’t show the splash window
NoSplashDelay Disables the two second delay while the splash window is

displayed during PMdiff start-up.
file | folder An optional file or folder name. The file comparison 

window is opened for files, and the folder comparison 
window is opened for folders.

Automation Reference

There are three automation objects provided by PMdiff. You can create instances of these objects from within most 
automation clients. These include tools like Visual Basic, Visual C++, Visual J++, Microsoft Office, and Borland 
Delphi.

PMdiff.Application

PMdiff.Application represents the PMdiff application. You can use this object to position the main application 
window, open file comparison windows, and to locate or activate a file comparison window.

PMdiff.FileComparison

PMdiff.FileComparison is used to represent two compared files. Only PMdiff.FileComparison objects obtained by a 
call to PMdiff.Application.CreateVisualFileComparison() will have user interfaces (windows). PMdiff.FileComparison 
objects created by other means will not, but the objects can still compare files, and report the results of 
comparisons via object properties and methods. Use this latter approach when it is not necessary to present a view
of the two compared files to a user.

PMdiff.FolderComparison

PMdiff.FolderComparison is used to represent two compared folders. A PMdiff.FolderComparison object can only be 
obtained by a call to PMdiff.Application’s CreateFolderComparison method.

PMdiff.Options

PMdiff.Options is used to read or modify the preferences used by PMdiff. Use this object to obtain the user 
preferences for tab expansion, whitespace ignoring when comparing files.

PMdiff.Options2

PMdiff.Options2 provides access to PMdiff preferences that are new to release 4.6.

Object methods and properties

Pmdiff.Application Type Name Description

Properties boolean Visible Determines whether the 
application window is 
visible or not.

IDispatch* ActiveDocument Identifies the active 
document.

long Left The left edge of the 



application window, 
relative to the screen.

long Top The top edge of the 
application window, 
relative to the screen.

long Width The width of the 
application window.

long Height The height of the 
application window.

Methods boolean Close() Closes the PMdiff 
application.

IDispatch* CreateVisualFileComparison() Creates a 
PMdiff.FileComparison 
visual file comparison 
object. This object can be 
used to display compared 
files. 

IDispatch* CreateFolderComparison() Creates a 
PMdiff.FolderComparis
on visual folder 
comparison object. This 
object can be used to 
compare and display 
folder hierarchies. 

Void Activate() Ensures that the PMdiff 
application window is 
open and visible on the 
screen.

void Minimize() Minimizes the PMdiff 
application window.

void Maximize() Maximizes the PMdiff 
application window.

void GiveUserControl() Gives control of PMdiff to 
the user. The application 
will not close when the 
automation client has 
freed all acquired objects.

void Restore() Restores the application 
window to its normal 
position and size.

Pmdiff.FileComparison Type Name Description

Properties boolean Visible Determines whether the 
file comparison window is 
visible or not.

Methods long CompareFiles(
BSTR lpstrFirstFile,
BSTR lpstrSecondFile,
long lExpandTabs,
long lIgnWhitespace,
long lIgnCase)

Compares two files. Set 
lExpandTabs to –1 to 
disable tab expansion or if
you don’t want tab 
characters converted to 
spaces before the files are
compared. PMdiff 
automatically expands tab
characters to spaces 
when compared files are 
displayed. Set 
lIgnWhitespace to 0, 1, 
or 2 to use, ignore all, or 



ignore leading whitespace
in lines. Set lIgnCase to 
0 or 1 to do a case-
sensitive or case-
insensitive comparison. 
Returns an error code, 
which is 0 for no-error. 
See below.

long CompareFiles2(
BSTR lpstrFirstFile,
BSTR lpstrSecondFile)

Compares two files. The 
behaviour is identical to 
CompareFiles, except 
that the tab expansion, 
whitespace, and case 
options are taken from 
the PMdiff user 
preferences.

BSTR GetLineData(
long lFile,
long lLine)

Gets the data contained 
within a line. This will 
include line-ending 
characters. lFile is 0 or 1 
for the first or second file.
lLine is a 0-based line 
number.

long GetChangeStartLine(
long lFile,
long lChangeNumber)

Gets the line number at 
which a particular change 
block begins.

long GetChangeLength(
long lFile,
long lChangeNumber)

Gets the number of lines 
within a change block.

long GetLineState(
long lFile,
long lLine)

Gets the state of a line. 
This can be 0, 1, 2, or 3 
for unchanged, changed, 
inserted, or removed.

long GetLineLength(
long lFile,
long lLine)

Gets the length of a line. 
This will include line-
ending characters.

long GetNumberOfChanges() Gets the number of 
changes (change-blocks) 
between the two files.

long GetNumberOfLines(
long lFile)

Gets the number of lines 
in a file.

long GetComparisonResult() Gets the comparison 
operation result. This is 0 
or 1 for same or different.

long GetComparisonError() Gets the comparison error
result. This is 0 for no-
error. See below.

IDispatch* GetApplication() Gets the 
PMdiff.Application 
object representing the 
PMdiff application.

void Close() Closes the file comparison
object.

void SetPanelTitles(
BSTR lpstrFirstTitle,
BSTR lpstrSecondTitle)

Provides file titles for the 
file comparison window to
use in place of the two 
filename drop-down lists. 
The file titles are intended
to be human-readable 



descriptions for the 
compared files. They do 
not have to be filenames.
All visual occurrences of 
the compared filenames 
are replaced by these two
file titles. 

void GiveUserControl() Gives control of PMdiff 
and the file comparison 
object to the user. Neither
the file comparison object
nor the PMdiff application 
will close when the 
automation client releases
them.

void Minimize() Minimizes the file 
comparison window.

void Maximize() Maximizes the file 
comparison window.

void Restore() Restores the window to 
its normal position and 
size.

Errors returned by CompareFiles and GetComparisonError:

Value Name Meaning

0 NoError Not an error – success.
1 OutOfMemory Not enough memory to process the request.
2 File1NotFound Couldn’t find the first file.
3 File2NotFound Couldn’t find the second file.
4 CantReadFile1 Couldn’t read the first file.
5 CantReadFile2 Couldn’t read the second file.
6 CantGetFile1Info Couldn’t get the size of the first file.
7 CantGetFile2Info Couldn’t get the size of the second file.
8 InvalidSetup Attempted to query results before performing a comparison.
9 AlreadyDiffed Should never occur.
10 ChangeTableError Problems were encountered while building the change tables. 

Probably due to insufficient memory.
11 NeitherFileFound Neither file could be located.
12 InternalError              If you get this, then let us know!

Pmdiff.FolderComparison Type Name Description

Properties bool Visible Determines whether the 
folder comparison window
is visible or not.

bool Busy Determines whether a 
folder comparison 
operation is in progress. 
After starting a folder 
comparison operation, 
you can poll this property 
to see whether the 
operation has completed.

BSTR FileEntryName(
long lIndex,
short sSide)

The name of the file or 
folder item on the left 
(sSide == 0) or right 
(sSide == 1) at index 
lIndex.

short FileEntryType(
long lIndex,

The name of the file or 
folder item on the left 



short sSide) (sSide == 0) or right 
(sSide == 1) at index 
lIndex. See below for a 
list of entry type values.

long ItemsSelected The number of items 
selected in the list.

BSTR FolderName(
short sSide)

The name of the folder on
the left (sSide == 0) or 
right (sSide == 1).

BOOL Selected(
long lIndex)

The selected state of the 
item at index lIndex.

Methods void Close() Closes the folder 
comparison window.

void CompareFolders(
BSTR strFirstFolder,
BSTR strSecondFolder)

Compares the two named
folders.

short ComparisonError Returns the type of error, 
if any, that occurred 
during a folder 
comparison operation. 
This property is valid once
the comparison operation 
has completed (Busy is 
FALSE).

void Refresh() Refreshes the contents of 
the folder comparison 
view.

IDispatch* GetApplication() Gets the 
PMdiff.Application 
object representing the 
PMdiff application.

void GiveUserControl() Gives control of PMdiff 
and the folder comparison
object to the user. Neither
the folder comparison 
window nor the PMdiff 
application will close 
when the automation 
client releases them.

void Maximize() Maximizes the folder 
comparison window.

void Minimize() Minimizes the folder 
comparison window.

void Restore() Restores the window to 
its normal position and 
size.

void SetPanelTitles() Provides titles for the 
folder comparison window
to use in place of the two 
folder name drop-down 
lists. The folder titles are 
intended to be human-
readable descriptions for 
the compared folders. 
They do not have to be 
folder names.

long SelectChangedFiles() Selects the files in the list
that have been modified. 



Returns the number of list
rows that were selected.

long SelectAllFiles() Selects the entire 
contents of the list. 
Returns the number of list
rows that were selected.

long CompareSelectedFiles() Opens a file comparison 
window for each pair of 
selected files in the list. 
Returns the number of 
comparison windows that 
were opened.

void DeselectAllFiles() Deselects all the entries 
in the list.

long NumberOfEntries() The number of entries in 
the list.

void RetestSelected() Retests the selected files 
to see whether their 
(changed/unchanged) 
states need modification.

void Stop() Stops any outstanding 
comparison operations.

File Entry Types for FileEntryType:

Value Name Meaning

0 IdClosedFolder An expanded folder
1 IdOpenFolder An expanded folder
2 IdFile An unchanged file
3 IdDifferentFile A changed file
4 IdNewFile An inserted file (on the right)
5 IdDeletedFile A deleted file (on the left)
6 IdNewerFile The most recent version of a changed file.

PMdiff.Options Type Name Description

Properties BSTR UnchangedFont The font used to 
represent unchanged lines
in the file comparison 
window. This is either a 
text representation of the 
Win32 LOGFONT 
structure, or a simple font
style (eg. “8.Times New 
Roman (Bold)(Italic)”)

BSTR ChangedFont The font used to 
represent changed lines in
the file comparison 
window.

BSTR InsertedFont The font used to 
represent inserted lines in
the file comparison 
window.

BSTR RemovedFont The font used to 
represent removed lines 
in the file comparison 
window.

BSTR EditFieldFont The font used for the 
filename edit fields.



BSTR FileListFont The font used for the 
folder comparison 
window’s file list.

BSTR FileFilter A list of semicolon or 
comma separated 
patterns for files to filter 
out when comparing 
folders.

OLE_COLOR UnchangedFgnd The color used for 
unchanged lines in the file
comparison window.

OLE_COLOR ChangedFgnd The color used for 
changed lines in the file 
comparison window.

OLE_COLOR InsertedFgnd The color used for 
inserted lines in the file 
comparison window.

OLE_COLOR RemovedFgnd The color used for 
removed lines in the file 
comparison window.

OLE_COLOR LinkingLinesFgnd The color used for the 
change linking lines in the
file comparison window.

OLE_COLOR OverviewFgnd The color used for the file 
overview strips in the file 
comparison window.

bool ExtendLinkingLines Extends the linking lines 
across the file panels.

bool ExpandTabs Expands tab characters 
when displaying files in 
the file comparison or 
merging windows.

bool LinkVertically Links the two files 
together when scrolling 
vertically.

bool LinkHorizontally Links the two files 
together when scrolling 
horizontally.

bool MaximizePMdiffOnStart Maximizes the PMdiff 
window when it first 
opens.

bool MinFldrCompAfterComparingFi
les

Minimizes folder 
comparison windows 
when they have finished 
opening file comparison 
windows for selected files.

bool ShowLineNumbers Shows line numbers in 
the file comparison 
window.

bool DelayedLink Delays horizontal and 
vertical linking until the 
scroll bar is released.

short IgnoreWhitespace Controls how whitespace 
is treated when files are 
compared: 0 = 
whitespace is significant, 
1 = leading whitespace is 



ignored, 2 = all 
whitespace is ignored.

bool CloseOnErrorOrNFF Closes file comparison 
windows when opened by 
the folder comparison 
window if there was an 
error during comparison, 
or neither file could be 
found.

bool CloseOnNoChanges Closes file comparison 
windows when opened by 
the folder comparison 
window if there were no 
changes between the two 
files.

bool LimitOpenedViews Limits the number of file 
comparison that can be 
opened by folder 
comparison windows at 
any one time.

short OpenViewLimit The maximum number of 
file comparison windows 
that can be opened by 
folder comparison 
windows at any one time.

bool HideCRLF Hides the carriage return 
and line feed characters 
at the end of each line in 
file comparison windows.

bool ShowLinkingCentre Shows a center marker in 
the linking lines panel in 
the file comparison 
window.

bool ShowOverviewStrips Shows change overview 
strips in the file 
comparison window.

bool EnableMerging Enables merging support 
in file comparison 
windows.

bool PerformThoroughComparison Files are fully compared 
during a folder 
comparison operation.

bool RecursiveFolderComparison Sub-folders are also 
compared during a folder 
comparison operation.

bool ShowInsertedRemoved Includes inserted and 
removed files in the folder
comparison results list.

bool ShowUnchangedFiles Includes unchanged files 
in the folder comparison 
results list.

bool UseFileFilter Enables the use of the file
and folder pattern filter 
when comparing folder 
hierarchies.

bool IgnoreCase Ignores the case of 
characters when 



comparison files.

bool OpenInitialComparisonWindow Opens an initial empty file
comparison window when 
PMdiff starts.

bool ConfirmPMdiffClose A confirmation message 
box is displayed when 
PMdiff is closed by the 
user. 

bool FolderPrintShowLineNumbers Displays line numbers in a
folder comparison 
printout.

short FolderPrintMarginUnits The units to be used for 
the margins in a folder 
comparison printout. 0 = 
inches, 1 = centimeters.

bool FilePrintShowLineNumbers Displays line numbers in a
file comparison printout.

short FilePrintMarginUnits The units to be used for 
the margins in a file 
comparison printout. 0 = 
inches, 1 = centimeters.

bool ShowFileTimestamps Shows last-modified 
timestamps for files in the
folder comparison results 
list.

bool FindMatchCase Enables the match case 
option in Find dialogs.

bool FindWholeWordOnly Enables the whole word 
only option in Find 
dialogs.

short FindRange (unused) Sets the search 
range used in Find 
dialogs. 0 = whole 
document, 1 = current 
selection.

bool MergeEditorWordWrap Enables word-wrapping in
the merged file editing 
window.

short FilePrintWordWrap Enables word or character
wrapping in file 
comparison printouts.

bit 0: unset = no 
wrapping, set = enable 
wrapping.

bit1: unset = word-
wrapping, set = 
character-wrapping.

short ExpandTabsTo The number of spaces to 
expand tab characters to.

short HistorySizes The maximum number of 
entries in the find, file, 
and folder history lists.

BSTR FindHistory(
short sIndex)

The entry at index 
sIndex in the Find 
dialog’s Find what: list.



BSTR ReplaceHistory
short sIndex)

The entry at index 
sIndex in the Replace 
dialog’s Replace with: 
list.

BSTR UnchangedMergeFont(
short sSide)

The font used to 
represent unchanged lines
from (sSide == 0) the 
first file, or (sSide == 1) 
the second file in the 
merged file editing 
window.

BSTR ChangedMergeFont(
short sSide)

The font used to 
represent changed lines 
from (sSide == 0) the 
first file, or (sSide == 1) 
the second file in the 
merged file editing 
window.

BSTR InsertedRemovedMergeFont(
short sSide)

The font used to 
represent (sSide == 0) 
removed lines in the first 
file, or (sSide == 1) 
inserted lines in the 
second file in the merged 
file editing window.

BSTR FolderHistory(
short sSide,
short sIndex)

The entry at index 
sIndex in (sSide == 0) 
the first folder list, or 
(sSide == 1) the second 
folder list in the folder 
comparison window.

BSTR FileHistory(
short sSide,
short sIndex)

The entry at index 
sIndex in (sSide == 0) 
the first file list, or (sSide
== 1) the second file list 
in the file comparison 
window.

OLE_COLOR UnchangedMergeFgnd(
short sSide)

The colour font used to 
represent unchanged lines
from (sSide == 0) the 
first file, or (sSide == 1) 
the second file in the 
merged file editing 
window.

OLE_COLOR ChangedMergeFgnd(
short sSide)

The colour used to 
represent changed lines 
from (sSide == 0) the 
first file, or (sSide == 1) 
the second file in the 
merged file editing 
window.

OLE_COLOR InsertedRemovedMergeFgnd(
short sSide)

The colour used to 
represent (sSide == 0) 
removed lines in the first 
file, or (sSide == 1) 
inserted lines in the 
second file in the merged 
file editing window.

double FilePrintLeftMargin The size of the left margin
in file comparison 



printouts.

double FilePrintRightMargin The size of the right 
margin in file comparison 
printouts.

double FilePrintTopMargin The size of the top margin
in file comparison 
printouts.

double FilePrintBottomMargin The size of the bottom 
margin in file comparison 
printouts.

double FolderPrintLeftMargin The size of the left margin
in folder comparison 
printouts.

double FolderPrintRightMargin The size of the right 
margin in folder 
comparison printouts.

double FolderPrintTopMargin The size of the top margin
in folder comparison 
printouts.

double FolderPrintBottomMargin The size of the top margin
in folder comparison 
printouts.

PMdiff.Options2 Type Name Description

Properties BSTR IncludeFileFilter A list of semicolon or 
comma separated 
patterns for files to 
include when comparing 
folders.

bool UseIncludeFileFilter Enables the use of the file
and folder pattern filter 
when comparing folder 
hierarchies.

bool CopyFilesAutoFolderCreate Controls the automatic 
creation of folders when 
copying files in the Copy 
Files window.

bool PrintOnlyPagesWithChanges When set to TRUE, only 
pages containing changes
will be included in file 
comparison printouts.

bool SelectRightChangesDefault When set to TRUE, 
Changes will be selected 
from the second file by 
default in file comparison 
windows.



Moves the cursor to the previous change.



Select this option to set the measurement unit to inches.



Click to change the text style used for unchanged lines from the second file.



Select this option to set the measurement unit to centimeters.



Shows or hides the editing toolbar.



Click to change the text style used for unchanged lines from the first file.



There is insufficient disk space to save the merged file.



Compares the selected files in the list. A file comparison window is opened for each pair of selected files.



Edit the contents of this field to modify the width of the right-hand margin of the page.



An error occurred while saving the merged file. You are probably running short of disk space.



Use this window to replace instances of a specified piece of text. Enter the search text into the Find what field. 
Enter the replacement text into the Replace with field. Select the Replace button to replace the selected text in 
the window with the replacement text. Select the Replace All button to replace all instances of the search text 
with the replacement text. The Selection and Whole file radio-buttons can be used to modify the range within 
which the search and replace operation is carried out.



PMdiff was unable to remove a temporary file created while saving a merged file. You can safely remove PMdiff 
temporary files using the Windows Explorer or a Command Prompt. PMdiff temporary files are named tmp####, 
where # is a numeric digit.



This list contains the names of all the open file comparison and editing windows. You can multiple-select windows 
in this list. Select the Switch To button to activate the highlighted windows. Select the Close Window button to 
close the highlighted windows. 



PMdiff was unable to open the clipboard in order to copy the selected text. Another application is probably using 
the clipboard at the moment.



Click to change the text style used for removed lines from the first file. 



Select this option to enable word wrapping in the merged file editing windows.



Select this option if you want the merged file to be saved with lines ending in a single line-feed character. UNIX 
text files usually follow this convention.



Select this option if you want the merged file to be saved with lines ending in a carriage-return and line-feed 
character sequence. Windows and MSDOS files usually follow this convention.



Toggles the active file comparison window between being split horizontally and vertically.



Toggles the active file comparison window between being split vertically and horizontally.



Refreshes the contents of the current window.



Select this button to display the standard Printer Setup dialog that you can use to modify printer settings.



Opens the Araxis home page.



Selects removed and changed lines in the first file.



Edit the contents of this field to modify the width of the left-hand margin of the page.



Enter the search text into this field, or choose a previous search text from the drop-down list.



Shows the current line number.



Use this window to find a specified piece of text. Enter the search text into the Find what field, and then select the
Find button to locate the next occurrence of the text.



PMdiff was unable to save the merged file properly. The existing file on disk has not been modified in any way as a 
result of this.



Select this button to close all the highlighted windows in the list.



Select this option if you want the search text to only match complete words.



Edit the contents of this field to modify the width of the bottom margin of the page.



Select this button to replace the highlighted text in the document with the replacement text.



Select this option to restrict the search and replace scope to the selected portion of the document.



Select this option to enable the search and replace operation to cover the entire document.



Shows or hides time and date stamps for files in the folder comparison list.



Use this control to increase or decrease the number of the last page to be printed.



Enter the text to replace the search text with into this field, or select an entry in the drop-down list box.



Saves the merged file to the first file in the file comparison window.



Saves the merged file to the second file in the file comparison window.



Use this control to increase or decrease the size of the bottom page margin.



Selects inserted and changed lines in the second file.



Finds the previous occurrence of the specified search text.



Use this window to select a filename to save the merged file as.



The Merging Options Page

Enable file merging
Check this option to enable the selection check boxes in the file comparison window. You can use the checkboxes to
select the groups of unchanged, changed, removed and inserted lines that will form a merged file.

Editing window styles
The merged file editing window uses a number of different styles to represent groups of lines from the two 
compared files. Use the buttons below to modify the styles that are used when creating the contents of the editing 
window. 

From first file
These settings affect lines taken from the first file.

Unchanged Lines
Select this button to change the style used to represent unchanged lines from the first file.

Removed Lines
Select this button to change the style used to represent removed lines from the first file.

Changed Lines
Select this button to change the style used to represent changed lines from the first file.

From second file
These settings affect lines taken from the second file.

Unchanged Lines
Select this button to change the style used to represent unchanged lines from the second file.

Inserted Lines
Select this button to change the style used to represent inserted lines from the second file.

Changed Lines
Select this button to change the style used to represent changed lines from the second file.

Enable word wrapping in editing window
Check this option to enable word wrapping in the merged file editing window. If this option is unchecked, then a 
horizontal scroll bar is made available and lines will extend off the right hand edge of the window.

Related Topics:

  Options



Opens a window containing an editable version of the merged file. Selected changes from the first and second file 
are interleaved to form the merged file.



If you would like to save the changes you have made in this window, then select Yes. If not, select No. If you want
the editing window to remain open, then select Cancel.



Deletes the character at the cursor, or the current selection.



Use this control to increase or decrease the size of the top page margin.



Use this control to increase or decrease the number of the first page to be printed.



Editing toolbar.



Enter the number of the last page to be printed into this field.



Use this window to manage the windows you currently have open within PMdiff.

You can multiple-select windows in the list. Select Close Window to close all highlighted windows in the list. 
Select Switch To to activate all highlighted windows.



Select this option to preserve the original line ending characters when saving the merged file.



Select this button to close the window and keep all the changes made to the printing options.



Opens the Araxis patches and upgrades home page.



Check this option to make the search case-sensitive.



Check this option to include line numbers in the printout.



Select this button to replace all occurrences of the search text with the replacement text. The operation is carried 
out over the range specified by the Selection and Whole file buttons.



The specified search text was not found.



Edit the contents of this field to modify the width of the top margin of the page.



PMdiff was unable to create a temporary file to save the merged file to. You either don’t have the required access 
rights to modify files in the save directory, or you are running low on disk space.



PMdiff encountered problems while trying to replace the original file with the new saved file. While attempting to 
undo the filing operations it had done, PMdiff encountered another unexpected error that it was unable to recover 
from. This could be due to files being deleted, renamed, or having their permissions changed while PMdiff was 
saving the file.

The message box contains the names of the files involved. You will need to resolve the problems with the files 
manually before proceeding.



Select this button to display a preview of the printed document.



PMdiff was unable to replace the file on disk. It’s probably marked read-only or you don’t have the right access 
permissions to modify it.



Moves the cursor to the next change.



Use this control to increase or decrease the scaling factor applied to the printed text.



Enter the number of the first page to be printed into this field.



Opens the PMdiff home page.



Click to change the text style used for inserted lines in the second file. 



Use this control to increase or decrease the size of the right page margin.



Editing Merged Files

Use this window to edit a merged file before saving it.

File comparison windows are responsible for constructing merged file editing windows. The file comparison includes
all the lines that have checked check-boxes. Lines are color coded so that you can tell which of the two files each 
line comes from. By default, blue lines are lines from the first file, and red lines are from the second file.

Use Ctrl + Page Up and Ctrl + Page Down to move to the previous and next changes in the file, or use the 

previous and next change  buttons on the toolbar.

A popup menu containing commonly used commands will appear if you right-click within the file editing area.

When you have finished editing the merged file, you can use a Save  command from the File menu to save the 
file.

You can change the line styles and colours that are used in this window by changing the options within the PMdiff 

options window. Select the Options...  command from the View menu, and go to the Merging page.

Related Topics:

  Comparing Files      Merging Files

  Comparing Folders      Options



Edit the contents of this field to increase or decrease the scaling factor applied to the printed text.



Use this control to increase or decrease the size of the left page margin.



Selects the files that have been modified between the first and second folder structures.



Use this window to modify printing options, preview a printout, or print the active document.



Click to change the text style used for changed lines in the second file.



Click to change the text style used for changed lines in the first file. 



Select this button to deselect all the highlighted entries in the list.



Finds the next occurrence of the search text.



Folder comparison toolbar.



Select this option to so that the line is broken at the last visible character rather than at the last visible word. 



To upgrade your PMdiff settings so that they can be used with this new version of PMdiff, click Yes. If you would 
prefer to use this new version’s default settings, click No. If you want to defer this decision until the next time you 
start PMdiff, then select Cancel.



Check to wrap long lines so that the entire contents of each line is visible on the page. If this option is unchecked, 
then long lines will extend off the edge of the page and some of their content will not be visible.



Select this option to so that the line is broken at the last visible word rather than at the last visible character. 



HID_EDIT_REPEAT



HID_RECORD_FIRST



Selects all the text in the document.



Closes the print preview window.



Clears the current selection.



Displays the print dialog for the document being previewed.



HID_FILE_UPDATE



Pastes the information on the clipboard to the current location within the document.



HID_FILE_SEND_MAIL



Zooms in on the previewed printout.



HID_RECORD_LAST



HID_RECORD_NEXT



HID_RECORD_PREV



Copies the current selection to the clipboard.



Displays a dialog that you can use to find some text within the document.



Redoes the last undone operation.



Undoes the last operation.



HID_AFX_PREVIEW_NUMPAGE



HID_FILE_SAVE_COPY_AS



HID_FORMAT_FONT



HID_INDICATOR_CAPS



HID_INDICATOR_KANA



HID_INDICATOR_SCRL



HID_OLE_VERB_LAST



HID_OLE_EDIT_CONVERT



HID_EDIT_PASTE_SPECIAL



HID_TabKey



HID_OLE_EDIT_CHANGE_ICON



HID_OLE_EDIT_PROPERTIES



HID_FILE_MRU_FILE11



HID_FILE_MRU_FILE12



HID_FILE_MRU_FILE13



HID_FILE_MRU_FILE14



HID_FILE_MRU_FILE15



HID_FILE_MRU_FILE16



HID_FILE_MRU_FILE10



Saves the merged document with a new name.



HID_INDICATOR_EXT



HID_INDICATOR_NUM



HID_INDICATOR_OVR



HID_INDICATOR_REC



HID_ShiftTabKey



HID_ReturnKey



HID_FILE_PAGE_SETUP



HID_WIZBACK



HID_WIZNEXT



HID_WINDOW_SPLIT



Displays the printer setup window.



HID_OLE_VERB_FIRST



Displays a dialog that you can use to find and replace text within the document.



Zooms out of the previewed printout.



HID_FILE_NEW



HID_FILE_PRINT_DIRECT



HID_FILE_MRU_FILE2



HID_FILE_MRU_FILE3



HID_FILE_MRU_FILE4



HID_FILE_MRU_FILE5



HID_FILE_MRU_FILE6



HID_FILE_MRU_FILE7



HID_FILE_MRU_FILE8



HID_FILE_MRU_FILE9



HID_FILE_MRU_FIRST



Prints the active document.



HID_WIZFINISH



HID_OLE_EDIT_LINKS



HID_EDIT_PASTE_LINK



HID_FILE_OPEN



HID_FILE_SAVE



Shows the next page in the previewed document printout.



Shows the previous page in the previewed document printout.



Clears the entire document.



HID_OLE_INSERT_NEW



Cuts out the current selection and places it onto the clipboard.



Check to cause new file comparison windows to automatically maximize themselves when they open.



This control shows you how much of the evaluation period you have left.



This window displays the number of days you have left in the PMdiff evaluation period. 



You will need Windows 95 or Windows NT 4.0 (or above) to use PMdiff. PMdiff will not operate correctly on Windows
3.1, Win32s, or versions of Windows NT prior to 4.0.



Describes the state of the evaluation.



This control shows you how much of the evaluation period you have left.



Click to print the current document and save your printing options.



You will need Windows 95 or Windows NT 4.0 (or above) to use PMdiff. PMdiff will not operate correctly on Windows
3.1, Win32s, or versions of Windows NT prior to 4.0.



Click to find the next occurrence of the specified search text.



Click to close this dialog. 



Check to make PMdiff open an empty folder comparison window when PMdiff first starts.



Toggles the display of files that have been hidden by you with the Hide  command, and those hidden as a result 
of the Show unchanged files and Show inserted and removed files options in the Folder Comparison 
Options page.



Re-tests the selected files in the list to see if their unchanged/changed states need to be changed.



Opens a window that you can use to copy the selected files and folders from the right-hand folder hierarchy to a 
location in the left-hand hierarchy.



Stops any active folder comparison, or file re-test operation.



Displays the progress of any ongoing folder comparison operation.



Copies the named folder from the history list into the folder field.



Copies the named folder from the history list into the folder field.



Copies the named folder from the history list into the folder field.



Copies the named folder from the history list into the folder field.



Copies the named folder from the history list into the folder field.



Copies the named folder from the history list into the folder field.



Copies the named folder from the history list into the folder field.



Copies the named folder from the history list into the folder field.



Copies the named folder from the history list into the folder field.



Copies the named folder from the history list into the folder field.



Toggles the display of files that you have hidden with the Hide  command.



An error was encountered while scanning the contents of either or both folder hierarchies. The error encountered is
displayed within the message box.



Copies the named file from the history list into the filename field.



Copies the named file from the history list into the filename field.



Copies the named file from the history list into the filename field.



Copies the named file from the history list into the filename field.



Copies the named file from the history list into the filename field.



Copies the named file from the history list into the filename field.



Copies the named file from the history list into the filename field.



Copies the named file from the history list into the filename field.



Copies the named file from the history list into the filename field.



Copies the named file from the history list into the filename field.



Opens a window that you can use to copy the selected files and folders from the left-hand folder hierarchy to a 
location in the right-hand hierarchy.



Closes the folder comparison window.



Displays a list of previous entries in the field.



Hides or shows all the files currently selected in the list of files. You can view hidden files by using the Show 
Hidden command or toolbar button.



Displays a list of previous entries in the field.



Check this option to include only those files and/or folders that match the patterns in the adjacent entry field.



Enter the patterns that match the types of file that should be included when comparing folders. For example, enter 
*.doc to include all files ending in .doc. Use the ; or , characters to separate multiple patterns. Use a trailing \ 
character to distinguish folders from files. You can also enter non-wildcard names of specific files or folders that 
you would like to be ignored. You should generally include a pattern of *\ to include folders in the list, or PMdiff 
will only examine the top-level of the two folder hierarchies.



Versions of PMdiff prior to 4.6 did not distinguish between filter patterns that specified files and those that specified
folders. PMdiff 4.6 and later now require this distinction to be made. For a pattern to match a folder, it should end 
with a \ character. Such a pattern will only match folders. If a pattern does not end with a \ character, then it will 
only match files.

This change was required in order to support the ability to include all folders in the new file inclusion filter in the 
Folder Comparison Options page.

Some example filters:

*.cpp;*.h;WinDebug\;WinRel\

Matches files ending in .cpp and .h, and the folders WinDebug and WinRel.

*.cpp;*.h;WinDebug;WinRel

Matches files ending in .cpp and .h, and the files WinDebug and WinRel.



This field contains the name of the file being viewed in the panel below. Edit the contents and press Enter (or click 

Refresh ) to open a different file.



Selects all items in the file list.



Check this option to have PMdiff print and preview only those pages in the compared documents that contain 
changes (inserted, removed, or changed lines).



Copying Files

This window enables you to copy a set of files to a new location.

Destination Path
This field contains the path to the destination folder. The files and folders contained within the list below will be 
copied below the destination folder.

File List
This list contains the files and folders that were selected in the folder comparison window. Their current location is 
displayed in the Source column, and it relative to the folder structure that is being copied from. The path that the 
files will be copied to is displayed in the Destination column. It is automatically updated as you modify the 
contents of the Destination Path field.

Create required folders automatically
If PMdiff needs to create any folders below and including the destination path, then it will ask you to confirm that 
the folders should be created. By checking this option, you can instruct PMdiff to create the folders automatically 
without asking.

When files or folders are copied from one hierarchy to another, their relative positions within the hierarchies are 
preserved. For example, if two folders c:\old-docs and c:\docs are compared, and a file meetings\010298.txt 
is copied with the Copy To Right command, then the file list will contain an entry meetings\010298.txt. When 
the OK button is clicked, the file will be copied to c:\docs\meetings\010298.txt. If the meetings folder does 
not already exit below c:\docs, and the Create required folders automatically option is unchecked, then you 
will be asked to confirm the creation of the meetings folder.

If a folder is included in the list for copying, then the folder and everything that it contains will be copied.

Related Topics:

  Comparing Folders

This entry field contains a list of the files contained within the two folder hierarchies. Select items in this list, and 
then use the commands in the toolbar and menus to operate on them. 
This field contains the name of the file being viewed in the panel below. Edit the contents and press Enter (or click 

Refresh ) to open a different file.



Click to move to the previous change.



Check this option to create any required new folders below the destination path automatically. If left unchecked, 
you will be prompted when a new folder needs to be created.



This field shows the current line number. Edit the contents and press Enter to move to a specific line.



This control shows the current line number. Edit the contents and press Enter to move to a specific line.



This field holds the copy operation destination path, below which items in the list will be copied to.



Click to move to the next change.



Click to browse for a folder.



Click to move to the next change.



Click to move to the previous change.



Click to copy the files contained within the list to their new location under the destination path. You may be 
prompted if the copied files already exist in the new location.



Contains the merged file. Edit the merged file, and then select one of the Save  commands from the menu or 
toolbar.



When two files are compared in a file comparison window, and merging is enabled, PMdiff will select all the changes
in the left-hand file by default. By checking this option, you can change this behavior and have PMdiff select all the 
changes from the right-hand file by default.



This list contains the names of the files that are to be copied, and their destination paths.






